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Product Description

Running on the Snap-on VERUS® or VERDICT™ diagnostics platforms, the Shop
Management SE Viewer application allows the service technician to view the next assigned job
without the need to leave the service bay. Repair Orders written by the service advisor at the
service counter are stored in the shop management database and are transmitted wirelessly to the
service bay via the shop’s network (requires wireless network hardware). After performing
repairs, the technician may return back notes, update the status of the repair, update the mileage
out, and update the vehicle’s location. The information submitted by the service technician may
then be viewed at the front counter by the service advisor.

Technical Requirements

The Shop Management SE Viewer application is supported on Snap-on VERUS and VERDICT
Diagnostics scan tool platforms running Software Bundle 10.4 (Version 2.0.0.2158) or later
diagnostic module software. Microsoft .NET 2.0 or above must be present on the VERUS or
VERDICT.

The Shop Management SE Viewer application is compatible with version 6.4 or above of
ShopKey Service Writer SE, and Shop Management SE. The Shop Management SE Viewer
application is compatible as well with version 6.4 or above of Mitchell 1 Manager SE, and
ManagerPlus SE. An active subscription to one of these shop management products is required
to make use of the Shop Management SE Viewer.



Installation

After downloading the Shop Management SE Viewer application, begin the installation by
selecting the .exe in the folder you downloaded the file to, or select the icon on your desktop if
that was the download destination.
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When the InstallShield Window appears, select “Next” to begin installation.



Welcome to the InstallShield Wizard for Shop
Management SE Viewer

The Installshield(R) Wizard will install Shop Management SE
Viewer on your computer, To continue, dick Mext,

© 2010 Mitchell1 Repair Information Company, LLC. All Rights
Reserved.

< Back i Mext = i [

Accept the End User License Agreement and select “Next.”

. IE‘ Shﬂp Management

License Agreement

Please read the following license agreement carefully.

MITCHELL 1% END USER LICENSE AGREEMENT

This MRIC END USER LICENSE AGREEMENT (the "Agreement”) is by and
between MITCHELL REPAIR INFORMATION COMPANY, LLC, P.O. Box
509044, San Diego, California 92150-9044 ("MRIC") and the company or
individual identified on the MRIC Order Form that references this Agreement
("End User").

1. Order Form. The "Order Form" consists only of the information provided
and selartad v Fad lsar nn the MBI Cirdar Farm that referenres this s

(@) I accept the terms in the license agreement

(7)1 do not accept the terms in the license agreement

Installshield

< Back ][ Mext = ] [ Cancel




Choose “Typical” then “Next” to install in the standard folder location. Or, select “Custom” and
choose a custom install destination.

Setup Type
Choose the setup type that best suits your needs,

Please select a setup type.

@ Typical

The program will be installed in the default location.

Choose the location the program will be installed to. Recommended
for advanced users.

Installshield




Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description
Shop Management SE Viewer

Shop Management SE Viewer

This feature requires 368KE on
your hard drive.

Install to:
C:\Program Files (x88)M1-5K\shop Management SE Viewer,

Installshield

[ tep | spae |

Click “Install.”

Ready to Install the Program
The wizard is ready to beqin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Badk. Click Cancel to
exit the wizard,

Installshield




If required prerequisite applications are not found on your computer, these will automatically be
installed.

Installing Shop Management SE Viewer
The program features you selected are being installed.

Flease wait while the InstallShield Wizard installs Shop Management SE
Viewer, This may take several minutes.

Status:

Installshield




Click “Finish” to complete the installation process.

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Shop
Management SE Viewer. Click Finish to exit the wizard.

< Back Cancel







Use of the Shop Management SE Viewer

Connecting to a Database
When the Shop Management SE Viewer application is opened for the first time, a connection
must be established with a Shop Management SE database on the network.

To open the Shop Management SE Viewer application, click on the icon on your desktop, or
select the program through your Windows START menu.

=

Shop
Management

T —
| SE Viewer |

Single Database Located
The application will search the connected network for a Shop Management SE system database

and if one is located the application will automatically connect to this database and save this
database as the default for future connections.



Multiple Databases Located
If instead, more than one database is located in the connected network, you will be prompted to

select from the list. Once a database is selected from the list, select

Refresh List

Connect to specified database

Server Mame H15VZN1 Instance Name SHOPSTREAM

“Connect.”%

No Database Located
If instead, no databases are located in the connected network, you will be prompted with a blank

selection list. You may manually enter the “Server Name” and the “Instance Name.” Once
entered select “Connect.”

When the database connection is established you will be presented with the Work In Progress
(W.1.P) screen. If the application cannot establish a connection to the database you have selected
you will be prompted with a warning.

-
Shop Management SE Viewer Iﬁ

. Unable to connect to selected database. Choose "OK" to retain the
_l_}. current database selection for future connection attempts. Choose
"Cancel” to select a different databaze now.

| ok || Cancel




Navigation

You may navigate using a mouse, a pen stylus, or with a keyboard (space bar, tab button, and up
and down arrow keys).

The Work in Progress (W.I.P) screen

When the application opens and a database connection is established you will be presented with
the Work In Progress (W.I.P) screen.

The work in progress screen shows all the Estimates, Repair Orders, Invoices, Special Orders,
and Counter Sales in the Shop Management SE database.

“Refresh W.1.P” list refreshes the display to show the most current data available from the Shop
Management SE database.

I\ Shop Management SE [EE )
File View Help
Order Type Vehicle Technician

—_—
026434 BKSVH14 2000 Dodge Gr... Wu, Jﬂnes 21272007 5:00...
026430 AEJED30 1999 Ford Must __ WU. James In ng'm 2/14/2007 5:00. .
026437 AVLYS60 2001 Volkswag... Waters, Muddy In Progress 2/13/2007 5:00...
026450 A468THY 2002 Toyota Ca... WU. James In Progress 2/15/2007 5:00..
026452 4K0S845 2000 Ford Cont ... Waitman, Randy | In Progress 2/15/2007 5:00..
3DECB22 1993 Honda Ac... HALL. JERRY 2/15/2007 5:00._.
WOODN49 1949 MERCUR.... Clark. Doug In Progress 2/22/2007 5:00..

1994 Toyota Co... PLEASE. SELECT | In Progress 12/7/2010 5:00....
5D46091 1995 Dodge Da... Waitman, Randy | In Progress 2/8/2007 5:00:...
BWATS533 1995 BMW 325is WU. James Waiting for esti___ | 1/24/2007 5:00.__
DDKO093 1960 Ford Clark. Doug Waiting For Parts | 12/31/2006 5:0...
AHBV225 1999 Ford Expe... Williams, Steve In Progress 2/9/2007 5:00-..
IXTU8S7 1998 Chevrolet ... Maccini, Todd In Progress 4/8/2002 5:00:..
3J70052 1986 Ford RV C__. Waitman. Randy |Completed-left . | 12/19/2006 5:0...
026441 BVa8631 1999 Dodge Da. .. WU. James Completed & Ca... | 2/14/2007 5:00. ..
026384 3HOM126 1994 Ford Thun... WU. James Completed & Ca... | 2/2/2007 5:00:...
010545 6H20349 1991 Ford Ran... PLEASE. SELECT Completed & Ca... | 4/4/2001 5:00:...
026239 2WMC212 1990 Jeep Cher.__ WU. James Completed & Ca___ | 1/8/2007 5:00-__.
078085 6AG3IF17 1991 Ford Ran... 27272007 5:00..
062970 3/5/2007 5:00:...
020392 2001 Nissan Fr... PLEASE, SELECT 3/2/2007 5:00....

026453
062971
026415
026324
023601
026386
013785
026162

RO
RO
RO
RO
RO
RO
RO
RO
RO
INV
INV
INV
INV
INV
INV

[ Refreshwuip.List | [ oOpenoOrder |




The Order Screen
From the W.1.P screen, double clicking a line item, or highlighting the line item and selecting
“Open Order” changes the view to the Order screen.

1991 lsuzu Impulse XS
VIN: 1GDJ7H1P3MI513829 Lic: 5K93061 Odom. In: 175800 Customer: Clark, Gary

Written By: Waitman. Randy Promised: 9:51 AM 02/12/2007 Approved Order # 026427

Description Qty Part No. Tech Name

Belt - Fan & Power Steering K 4017453
Belt - Fan & Power Steering K 257455
Belt - Fan. A/C & Power Steering K 4017603
Belt - Fan. A/C & Power Steering K 257603
Belt - Fan. Altemator & Vacuum Pump K 4017490
Belt - Fan. Altemator & Vacuum Pump K 257490
Timing Set - 3 Piece K 103074




Viewing Line Item Details from the Order Screen
Double clicking on a line item or highlighting a line item and selecting “Open” displays
additional detail. When a line item is opened it can be viewed but not edited.

File  View Help

1991 lzuzu Impulze X5 Eng: Color: Hat #: 30
VIN: 1GDJ7H1P3MJ513829 Lic: 5K93061 Odom. In: 175800 Customer: Clark, Gary

Written By: Waitman. Randy Promised: 9:51 AM 02/12/2007 Approved Order # 026427

Description Qty Part No. Tech Name

Package: VIP #1 .| Kazenske. Cry...

+Htert

Belt - Fan & Power Steering

'
Part Item

Part Description

Belt - Fan & Power Steering

Part No. 4017453

Technician Waters. Muddy

Ref/Inv #




Editing a Record

The “Status” of the Order, the vehicle “Odometer Out”, and “Vehicle Location” may all be
edited from within the Shop Management SE Viewer using the selections on the bottom bar of
the Order screen.

File  View Help

1991 lsuzu Impulse XS
VIN: 1GDJ7H1P3MJI513829 Lic: 5K93061 Odom. In: 175800 Customer: Clark, Gary

Written By: Waitman, Randy Promised: 9:51 AM 02/12/2007 Approved Order # 026427

Description Gty Part No. Tech Name

Belt - Fan & Power Steering . 4017453
Belt - Fan & Power Steering i 257455
Belt - Fan, A/C & Power Steering i AD17603
Belt - Fan, A/C & Power Steering i 257603
Belt - Fan, Altemator & Vacuum Pump i AD174390

mp . 257490

Timing £ w&mﬂ:mlﬂ . 103074
mes

Completed-no answer
Completednot called
Customer Waiting
In Progress
In Progress + 1 day
Lein Sale pending
Need to assign tech
Need to talk to tech
Off location storage
On Hold
Parts / owernight
Waiting For Approval
Waiting for Car

Waiting for estimate
Waiting for Payment h‘
Waiting For Service
Waiting for Sublet

Status | In »| Odom. Out 0




Notes may be added to an Order by selecting “Add Note.”

=
File  View Help

1991 lzuzu Impulze X5 Eng: Color: Hat #: 30
VIN: 1GDJ7H1P3MJ513829 Lic: 5K93061 Odom. In: 175800 Customer: Clark, Gary

Written By: Waitman. Randy Promised: 9:51 AM 02/12/2007 Approved Order # 026427

Description Gty Part No. Tech Name

NOTES - Entry

Belt - Fan & Power Steering
Belt - Fan & Power Steering This is a note]
Belt - Fan. A/C & Power Steering !
Belt - Fan. A/C & Power Steering
Belt - Fan. Altemator & Vacuum Pu
Belt - Fan, Altemator & Vacuum Pu
Timing Set - 3 Piece




If the connection to the database has been lost temporarily a warning message will be displayed
when attempting to save a Note. You will need to move within wireless range if you are

operating a wireless network. When you have re- established connection to the database select
“Retry” and your Note will be saved.

File  View Help

1991 lsuzu Impulse XS
VIN: 1GDJ7H1P3MJI513829

Eng:
Lic: 5K93061

Calor:
Odom. In: 175800

Hat #: 30
Customer: Clark, Gary

‘Written By: Waitman, Randy

Promised: 9:51 AM 02/12/2007

Approved Order # 026427

Description

Qty

Part No. Tech Name

NOTES - Entry

Belt - Fan & Power Steering

Belt - Fan & Power Steering

Belt - Fan, A/C & Power Steering

Belt - Fan, A/C & Power Steering

Belt - Fan, Altemator & Vacuum Pul

Belt - Fan. Altemnator & Vacuum Pu

Timing Set - 3 Piece

This is a note.

.
Shop Management SE Viewer

Unable to connect to the Shop Management SE Database.

Please verify you are in network range of
the database/server and select "Retry.”

Retry

| |




Customizing Screen View
Screen view settings may be customized to the user’s preference. These settings will be retained
at application shut down and restart.

Through the “Options” button, the W.I.P. grid may be customized to show or not show the
following columns:

e Number

e Order Type
e Customer

e License

e License State
e Vehicle

e Color

e Technician
e Status

e Scheduled
e Promised

e Time-In

e Completed
e Location

e Hat

e Written By

Through the “Options” button, the W.1.P. grid may be customized to show or not show the
following Record Types:

e [Estimates
e Repair Orders
e [nvoices

e Counter Sales
e Special Orders



File  View Help

4KOS845 2000 Ford Cont ... 2/15/2007 5:00...
JDECE22 1993 Honda Ac... 2/15/2007 5:00...
— - - — gress 2/22/2007 5:00...

[ e 2s 2/15/2007 5:00...

Show Columns on W.ILP Show Record Types on W.ILP. = i.. | 1/24/2007 5:00...

Number Estimates 2/8/2007 5:00:....
Order Type Repair Orders : 2/13/2007 5:00...
[ Customer Invoices S 2/12/2007 5:00...
License Courter Sales = 2/14/2007 5:00..
D License state Special Orders ESS 127772010 5:00...
Vehicle _ --- | 1/8/2007 5:00:...
Color = ... | 4/4/2001 5:00:...
Technician £55 2/9/2007 5:00:...
Status = ... | 271472007 5:00...

[7] Scheduled ) __. | 2/2/2007 5:00-_.
Promised to Default Settings q 12/31/2006 5:0...
[ Time-in 2 ... | 12/19/2006 5:0...
[C] Completed 4/8/2002 5:00-__.

[] Location 2/27/2007 5:00....

[C] Hat 3/2/2007 5:00-...
[ Written By Cancel ] [ oK ] 3/59/2007 5:00:...

r
Shop Management SE Viewer
-

553538888888388§

[ Refreshwuip.List | [ oOpenoOrder |

Columns on the W.I.P grid (not the Order grid) may be sorted by single left mouse-clicking on
the column header. It’s possible to sort up to 3 columns at once by holding down the Control



(Ctrl) key on the keyboard while simultaneously mouse-clicking on the columns you wish to be

sorted.

Vehicle

1991 Ford Ran...

2/27/2007 5:00...

1994 Toyota Co..

12/7/2010 5:00...

3/5/2007 5:00:...

1993 Honda Ac...

2/15/2007 5:00...

1949 MERCUR...

2/22/2007 5:00...

2000 Ford Cont ..

2/15/2007 5:00...

2002 Toyota Ca...

2/15/2007 5:00...

1999 Dodge Da...

.| 2142007 5:00...

2001 Volkswag...

2/13/2007 5:00...

2000 Dodge Gr...

2/12/2007 5:00...

5D46091

1999 Ford Must ..

1995 Dodge Da...

‘Waitman, Randy

In Progress

2/14/2007 5:00...

2/8/2007 5:00:...

4HBV225

1999 Ford Expe. ..

Williams. Steve

In Progress

2/9/2007 5:00:...

3HOM126

1994 Ford Thun...

WU, James

Completed & Ca__.

2/272007 5:00:...

5VATS33

1995 BMW 325i=

WU, James

Waiting for esti.__

1242007 5:00...

2WMC212

1990 Jeep Cher.__

WU, James

Completed & Ca_..

1/8/72007 5:00:...

3J70052

1986 Ford RV C_..

‘Waitman. Randy

Completed-lLeft ___

12/19/2006 5:0...

DDK093

1960 Ford

Clark. Doug

Waiting For Part=

12/31/2006 5:0...

2001 Missan Fr...

PLEASE. SELECT

3/2/2007 5:00:...

3XTU8S7

1998 Chevrolet ..

Maccini. Todd

In Progress

4/8/2002 5:00:...

6H20349

1991 Ford Ran...

PLEASE. SELECT

Completed & Ca...

4/4/2001 5:00:_..

[ mefreshwuip.List | [ openorder |

Columns may be repositioned on both the W.1.P. grid and the Order grid by left mouse-clicking
on the column heading. Click and hold while simultaneously dragging the column to the

positioning of your choice.




File  View

Help

2000 Ford Cont...

Waitman, Randy

In Progress

2/15/2007 5:00..

3DECE22

1993 Honda Ac...

HALL. JERRY

2/15/2007 5:00..

WOODN43

1943 MERCUR...

Clark. Doug

In Progress

2/22/2007 5:00..

468THY

2002 Toyota Ca...

WU, James

In Progress

2/15/2007 5:00...

BVATH33

1995 BMW 325is

WU, James

Waiting for esti...

1/24/2007 5:00..

5D46091

1995 Dodge Da...

‘Waitman. Randy

In Progress

2/8/2007 5:00:...

4VLYS60

2001 Volkswag...

Waters. Muddy

In Progress

2/13/2007 5:00..

5KSVH14

2000 Dodge Gr-..

WU, James

In Progress

2/12/2007 5:00..

AEJEQ30

1999 Ford Must...

WU, James

In Progress

2/14/2007 5:00..

383383833333

1994 Toyota Co_.

PLEASE. SELECT

In Progress

12/7/2010 5:00..

2WMC212

1990 Jeep Cher. ..

WU, James

Completed & Ca__.

1/8/2007 5:00:..

6H20349

1991 Ford Ran...

PLEASE. SELECT

Completed & Ca...

47472001 5:00:_..

4HBV225

1999 Ford Expe...

Williams, Steve

In Progress

2/9/2007 5:00:...

5Va8631

1999 Dodge Da...

WU, James

Completed & Ca_..

2/14,/2007 5:00..

3HOM126

1994 Ford Thun...

WU, James

Completed & Ca__.

2/272007 5:00:_..

DDK093

1960 Ford

Clark. Doug

Waiting For Part=

12/31/2006 5:0...

370052

1986 Ford RV C...

Waitman, Randy

Completed-Left ...

12/19/2006 5:0..

3XTUBS7

1998 Chevrolet ...

Maccini. Tedd

In Progress

4/8/2002 5:00:...

6AB3717

1991 Ford Ran...

2/27/2007 5:00..

2001 Missan Fr__.

PLEASE. SELECT

3/2/2007 5:00:_..

3/5/2007 5:00:...

[ Refreshwuip.List | [ oOpenoOrder |

The “Text Size” option under the “View” menu changes the text size on the W.1.P. and Order

SCreens




=Y Shop M.

File | View | Help
Text Size  » Largest Vehicle Color Technician Status Promised

0264 RO Large suzu Imp azensl pgress i

026434 RO Bl | 2000 Dodge Gr-.. WU, James In Progress 2/12/2007 5:00....
026430 RO DWF 1999 Ford Must___ WU, James In Progress 2/14/2007 5:00..
026437 RO Smallest 2001 Volkswag... Waters. Muddy | In Progress 2/13/2007 5:00..
026450 RO 2002 Toyota Ca.. WU, James in Progress 2/15/2007 5:00...
026452 RO AKDS845 2000 Ford Cont ... Waitman. Randy | In Progress 2/15/2007 5:00...
026454 RO 3DECE22 1993 Honda Ac... HALL. JERRY 2/15/2007 5:00..
026453 RO WOODN43 1949 MERCUR_... Clark. Doug In Progress 2/22/2007 5:00...
062971 RO 1994 Toyota Co.. PLEASE. SELECT | In Progress 12/7/2010 5:00..
026415 RO 5D46091 1995 Dodge Da... Waitman. Randy | In Progress 2/8/2007 5:00-...
026324 RO BVAT533 1995 BMW 325is WU, James Waiting for esti._. | 1/24/2007 5:00...
023601 INV DDKD99 1960 Ford Clark. Doug Waiting For Parts | 12/31/2006 5:0...
026386 INV AHBV225 1999 Ford Expe... Williams. Steve | In Progress 2/9/2007 5:00:_..
013785 INV 3XTUSS7 1998 Chevrolet .. Maccini. Todd | In Progress 4/8/2002 5:00-...
026162 INV 3470052 1986 Ford RV C.._ Waitman. Randy | Completed-Left ___ | 12/19/2006 5:0...
026441 INV 5V98631 1999 Dodge Da... WU, James Completed & Ca_.. | 2/14/2007 5:00...
026384 INV 3HOM126 1994 Ford Thun... WU, James Completed & Ca... | 2/2/2007 5:00-...
010545 INV 6H20349 1991 Ford Ran... PLEASE. SELECT |Completed & Ca... | 4/4/2001 5:00-....
026239 INV IWMC212 1990 Jeep Cher.._ WU, James Completed & Ca__. | 1/8/2007 5:00-....
078085 EST 6AB3717 1991 Ford Ran._._ 2/27/2007 5:00..
062970 CSALE 3/5/2007 5:00-....
020392 CSALE 2001 Nissan Fr... PLEASE. SELECT 3/2/2007 5:00-...

[ Refreshwilh.List | | OpenOrder |

All custom settings are erased by selecting the “Reset Screen View to Default Settings”
button under “Options.”
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File  View

Help

Number

4K05845

2000 Ford Cont...

271272007 951
2/15/2007 5:00...

3DEC622

1993 Honda Ac...

2/15/2007 5:00...

r
Shop Management SE Viewer
-

2/22/2007 5:00...

Number
Order Type

[ Customer

License
[7] License state

Vehicls

Colar

Technician

553538888888388§

Status

2

[ Scheduled

E

Promised

[ Time-in

[[] Completed

[[] Location

7] Hat

[ Written By

Show Columns on W.1.P

Show Record Types on W.ILP.

Estimates
Repair Crders
Invoices
Courter Sales
Special Orders

Reset Screen View
to Default Settings

2/15/2007 5:00...

1/24/2007 5:00...

2/8/2007 5:00:...

2/13/2007 5:00...

2/12/2007 5:00...

2/14/2007 5:00...

12/7/2010 5:00...

1/8/2007 5:00:..

47472001 5:00:_..

2/9/2007 5:00:...

2/14/2007 5:00...

2/272007 5:00:_..

12/31/2006 5:0...

12/19/2006 5:0...

4/8/2002 5:00:...

2/27/2007 5:00...

Cancel |

3/2/2007 5:00:_..

3/5/2007 5:00:...

[ Refreshwuip.List | [ oOpenoOrder |




The Help Menu

Under the “Help” menu, select “Shop Management SE Database Connection” to view the
currently connected database or to select another.

(5] shop Managem ] [ s,

File  View | Help

Number | Shop Management SE Database Connection E Color
026427 Shop Management SE Viewer Help np 271272007 9:51_.
026434 About Shop Management SE Viewer 2/12/2007 5:00...
026430 AETEUST 1999 Ford Must ... 2/14/2007 5:00...
026437 4AVLYS60 . 2/13/2007 5:00...
026450 STH) 012 Tovata Ca NU _lames ! 2/15/2007 5:00...
2/15/2007 5:00_..
2/15/2007 5:00_..
2/22/2007 5:00...
12/7/2010 5:00...

2/8/2007 5:00:....
pocesKkKi it i | 1/24/2007 5:00...
12/31/2006 5:0...
2/9/2007 5:00-....
4/8/2002 5:00:....
.- | 1241972006 5:0__.
-- | 2142007 5:00_..
.. | 24272007 5:00-...
.- | 4742001 5:00:__.
.. | 14852007 5:00:...
2/27/2007 5:00...

3/5/2007 5:00:...
Connect to specified database 3/2/2007 5:00-...

Server Name H15VZN1 Instance Name SHOPSTREAM

HHHEEHHEEEEEEEEE

Refresh List

Refresh W.iLP.List | [ OpenOrder

Selecting “Shop Management SE Viewer Help” opens an internet browser page and
automatically navigates to the online help system.

Shop Management SE Database Connection
Shop Management SE Viewer Help np___

About Shop Management SE Viewer

RO FEJEUSU
§| 026437 RO 4VLYS60 2001 Volkswag....
u'wwmm
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